CIVILIZATION

TECHNICAL SUPPLEMENT

for Apple Macintosh computers Copynight © 1992, MicroProse Sottware, Inc

CONTENTS

REQUIRED
EQUIPMENT

INSTALLATION

[nstallation Concepts

Your copy of Civilization should contain a manual, this technical supplement folder, a
set of 3 1/2" disks, a registration card, and an order card for backup disks.

Computer: This simulation requires an Apple Macintosh computer with at least 4
megabytes of RAM and one 3.5" high density disk drive. A hard disk is strongly recom-
mended. Civilization requires approximately 5.5 megabytes of space in a hard drive.

Controls: The simulation is run with the mouse and keyboard.

Display: Civilization supports both 8 bit color and black & white graphics. When you
load the game, the program advises you if you are not in one of these two modes.

System: You must have a copy of the System Tools disk (containing version 6.0.7 or later
of the System file) that came with your Macintosh. To run Civilization under 6.0.7 the 32 bit
color Quikdraw option must be installed. If not installed, insert your 6.0.7 “Printing Tools”
disk into the floppy drive, click open the “Apple Color” folder then copy the “32-bit
Quickdraw” icon into your system folder and reboot your system.

Civilization is not copy-protected. This means you can copy the game files from the
original disks however you prefer — to other floppy disks, or to a hard disk. These files are
normal in all respects, and should not cause special problems when backing up, restoring, or
optimizing a hard disk. However, keep the original disks handy.
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LOADING
PROBLEMS?

This simulation is designed to run using copies of the original (distribution) disks
supplied in the box. We suggest initializing new disks before doing any copying — to make
sure the disk is “clean” and in good operating condition.

Format a Floppy Disk: Initialize blank disks according to the instructions that come with
your computer.

Copy to Newly Formatted Disks: Copy all files from the distribution disks to the blank
initialized disks. Store the distribution disks in a safe place and proceed to play or install from
the copies.

You can copy the original (distribution) disks onto a hard disk. Create a new folder in
your hard drive called “Civilization” or something else that is appropriate. Drag the
Civilization files from each of the game disks into that folder. Do not rename any of the files
provided. Also, all of these files must be in the same folder as the Civilization Application.

(1) Boot your machine using a system disk if you don’t have a hard drive.

(2) Insert Disks: When the desktop appears, remove the system disk if necessary and
insert the Civilization “A” disk. If you have two floppy drives, put the “B” disk in the second
drive. Use the copies made in the install instructions above.

(3) Load Program: Double-click on the Civilization icon. The game will begin loading.

(1) Turn on your machine.
(2) Load Program: Open your Civilization folder and double-click on the Civilization
icon. The simulation will begin loading.

If the program doesn’t load or run correctly, make sure there are no unnecessary Startup
documents (INITs), Control Panel documents (cdevs), or Chooser documents (rdevs) in your
System Folder. Some of these programs may use up memory or otherwise alter your system
environment in a way that conflicts with Civilization

If you still have problems, try loading Civilization on another machine. If it loads
correctly on that machine, your difficulties are probably in your hardware. We regret that we
know of no way in software to fix problems that exist within your hardware! If the problem
is in the hardware, you must fix the hardware. The most common problem is that disk drive
speed or alignment (especially alignment) is off. Have a local dealer or service department
readjust it. Be sure to treat your disk drives carefully—minor bumps can throw them out of
alignment. Similarly, Civilization may not work on other computers running a software or

hardware emulation of the Apple Macintosh.
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On the Macintosh Models which support 32-bit addressing; especially the Quadra,
Mac llci, Mac llfx, select the control panel from the Apple menu, then select the “memory”
control panel; turn “on” 32-bit addressing; then reboot your Macintosh. You are now ready
to launch Civilization.

If you have further problems unanswered by the above, contact MicroProse Customer
Service at (410) 771-1151 Monday through Friday, 9AM-5PM EST. Please have a pencil and
paper handy before your call.

Saved games no longer work as described in the manual. Instead, games are saved from
the File menu as you would expect in Macintosh software. To save a game you are playing,
pulldown the Filemenu and choose “Save.” The program generates a tentative name for your
game based on the name of your Civilization and the year. You may accept this name or
change it, and save the game to any drive available.

You may save as many games as you wish to any available drive, subject only to space.

You canrestoreasaved game in three ways. You candouble-click on the saved gameicon
in the game folder, you may choose to load a saved game from the pre-game options menu
when starting up. In the two latter cases the program then lists all saved games available
from the active folder. You may access other folders and drives at this time to reach
additional saved games.

The interface of Civilization has been redesigned to take advantage of the Macintosh’s
user interface. Contrary to the manual, there is no optional “keyboard only” interface. The
following parts of the game have been redesigned with different or improved functionality.

To clear the Hall of Fame, trash “Hall of Fame” file.
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The map display has been broken into three parts and each one is now a functioning
Macintosh window. The world window and the map window are now separate, and the
palace window, status window, and unit identification window have been combined into one
status window. Within certain limits, these windows may be dragged, closed, sized, and
scrolled.

All three of these windows may be closed by using the respective close box or from the
Edit menu. Once closed, these windows may only be opened from the Edit menu.

When the game first loads, all windows are sized to fit on your monitor. The world and
status windows may not be enlarged beyond this size, but may be reduced by as much as fifty
percent. If your monitor has a large screen, you can increase the size of the map window so
that more of the map is visible. Be aware, however, that the larger you make your map
window, the more processing time needed for each map update and the slower the game.

If you do not have enough memory available to make the enlargement you wish, the
program limits the map to the maximum size it can support. A warning dialog tells you that
your memory must be increased for the map to be enlarged and notes how much memory is
required. To increase memory allocation, you must first quit the game. Then select the
Civilization Application icon and choose the option “Get Info” from the File menu. At the
bottom of the dialog box that opens, change the “Application Memory Size” to the number
suggested in the warning message.

Because the interface of Macintosh Civilization can be customized, the program remem-
bers user settings from session to session. For example, if you increase the size of the map
window and minimize the size of the world and status windows, the game boots that way the
next time you play. This is true whether you load a saved game or start a new game.

This information is kept in a file the program creates that is named “Civ Preferences.” To
reset the game to the default preferences, you must drag this file to the trash-can before booting
the game. When this fileis not present, the program createsa new one with the default settings.
Trashing the preferences file during play does not reset the defaults.

Scrolling: The map window scroll bars work as expected except for one feature. The
thumbs always reset to the middle of the bar. This happens because the world wraps
continuously.

Using the World Map: The box in the world window shows the exact area now seen in
the map window. Click in any part of the world window and the map window shifts to center
on thatarea of the world. Note that if you reduce the size of the world window, the world map

scales down.

Dragging the Map: To drag the map shown in the map window with the mouse, hold
down the Option key, and then click and drag the map.

Terrain Identification: To obtain information about the terrain in a map square, hold
down the Shift key, and then click on any square not occupied by a city or unit.
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Where necessary, all game menus have been redesigned to function as expected for
Macintosh software. Contrary to what is said in the manual, menus in the Macintosh version
cannot be pulled down by pressing the first letter of the menu’s name.

Highlighting Menu Options: The bulleted options within a menu may be highlighted
in three ways-

1. Moving the highlight with the cursor keys;

2. Pressing the key of the first letter of the option text;

3. Clicking once on the option text or button.

Accepting Menu Option: A menu option may be accepted in three ways-

1. Double-click on the option;

2. Press the “RETURN" or “ENTER” keys when the correct option is highlighted;

3. Click on the “Okay” button when the correct option is highlighted.

With the Mouse: To move a unit with the mouse, place the cursor on the active unit. As
you move the cursor around on top of the unit, the cursor changes into arrows pointing in the
eight directions the unit may move. When the cursor arrow points in the direction you wish
the unit to move, click and the unit moves one square in that direction.

With the Keyboard: If your keyboard has a numeric keypad, the active unit may be
moved by pressing keys 1-9, but not 5. For example, pressing the 8 key moves the unit straight
north, the 4 key moves it straight west, etc.

If your computer does not have a numeric keypad, you may use the following superim-

posed keypad-
U I O
] L
M

The cursor keys may also be used to move units in the four directions that they point.

Exiting Screens: To close any dialog box or window that doesn’t have a close box press
the Escape key.

View Palace: Place the cursor on the palace in the status window and click to open the
palace window.

Change Production: At the city display, to change the item being produced, click the
mouse pointer on the icon of the item currently under production. This opens the production
menu from which you may choose the new item to be produced.

Rush Jobs: To pay for the immediate completion of an item under production, from the
city display, hold down the Option key and click on the icon of the item being produced. A
dialog box opens giving you the option of paying for completion or not.



CONTROLS

Game Commands

Unit Commands From
Orders Menu

Function

Center map on active unit
Change menu highlight
Choose menu option
LLeave menu or screen
Scroll map

Toggle units on/off

Agricultural improvement*
Build fortress*/Fortify
Build Road*

Build Railroad*

Clear pollution®

Disband Unit

Found new city*

GoTo

Home city

Industrial improvement®
Move unit

No orders
Pillage

Sentry
Unload ship

Wait
* = Settlers only

Keyboard

CMD -]

Numeric keypad keys
Return key /Spacebar
Escape key

Option key + click + drag
CMD - X

CMD -1

CMD -F

CMD - R

CMD-R

CMD-K

CMD-D

CMD - B

CMD -G

CMD-H

CMD-M

Numeric keypad or
direction keys

vl 9

J L

. i

CMD - N or Spacebar
CMD-P

CMD-E

CMD-U

CMD-W

Mouse

Click mouse button
Click mouse button

or Click mouse
button
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File Menu

Advisors Menu

World Menu

City Display
Commands

Function

Save game

Change Tax rate
Change Luxury rate
Find city

Quit game

City Status

Military Advisor
Intelligence Advisor
Attitude Advisor
Trade Advisor
Science Advisor

Wonders of the World
Top 5 Cities
Civilization Score
World Map
Demographics
Spaceships

Auto Production
Change production map

Change Specialist
Change production

Rename city
General information
Happiness chart

Keyboard Mouse

CMD -5
CMD-T
CMD-L
CMD-?
CMD-Q

CMD-1
CMD-2
CMD -3
CMD -4
CMD -5
CMD -6

CMD-7
CMD -8
CMD-9
CMD-0
CMD - |
CMD - |

CMD- A
Click mouse button
Click mouse button

CMD-C

CMD-B

CMD-V

CMD-R

CMD -1

CMD-H
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Name Your Tribe

Additional File
Menu Options

Production

Unhappy People

Replay Options

The following additional game features were added to Civilization after the manual was
completed.

While selecting your pre-game options you may insert any name you wish for your tribe
instead of selecting one of the fourteen available from the Select Your Tribe menu. To insert
a name of your own, choose the option “Custom Tribe” when the Tribe menu opens. Then
type in the name you wish and press the Return key to enter it into the game. It is
recommended that the name be made plural, such as “Scots, Franks,” or “Hittites,” so that the
game text reads correctly. Thereafter, your civilization is known by this name.

There are two additional choices available under the Options selection of the File Menu
- Sound and Enemy Moves. As for all Options choices, a check-mark indicates the option is
on, and no check-mark indicates the option is off.

Sound: Choosing the Sound option toggles the music and sound effects off and on. Note
that Sound is not available when you are playing from floppy disks.

Enemy Moves: When on, the program shows you the moves of enemy units adjacent to
your units and any moves that occur on the part of map currently visible in the map display.
When off, you see only the enemy moves that cause combat. Turning off enemy moves may
have the effect of speeding play later in the game when there are many enemy units moving.

In addition, one other option needs further comment.

Animations: It is recommended that anyone playing from floppy disks turn off Anima-
tions as this significantly speeds play.

When the change production menu is open on the city display, showing what items can
be built in a city, some items may be marked with an* symbol. This symbol indicates that the
item has already been made obsolete by theadvance of technology, even though youmay still
build it.

Under the governments of the Republic and Democracy, people are made unhappy by

und units and ships not in their home city. People are also made unhappy by air units and
nuclear bomb units, regardless of where they are located.

When the game is complete (except when you retire), a menu opens offering the option
of reviewing a variety of replays of your civilization’s history. You can choose the Quick
Replay, the Complete Replay, or Write Replay to Disk.

Quick Replay: This replay shows the basic land mass of the world and proceedstoreport
the founding, capture, and destruction of cities by all civilizations throughout the game. From
this replay you can quickly see the rise and fall of civilizations and learn what was happening
while you were busy in your part of the world. This replay proceeds on its own.
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BLACK &
WHITE UNIT
ICON CHART

Complete Replay: The complete replay shows the information reported in the Quick
Replay, butalsoreports who firstachieves each civilization advance, who first builds each unit
and Wonder, changes in the state of war or peace between civilizations, and the destruction
of civilizations. At various dates this replay reports your standing in the world. The Complete
Replay stops after each information report. You must click your mouse to proceed.

Write Replay to Disk: Choosing this selection allows you to save a text file of the replay
that you can print out. A Mac dialog box opens from which you may give the file any name
you choose. As part of the replay information, a map of the world is also saved. This map
showsallland mass and the location and nati onality ofall cities. It also shows where cities that
have been destroyed were located. Once you have left the program you can open the file in
a word processing program and print it out.

When you retire, a Powergraph appears that shows the relative strength over time of the
civilizations in the game, including yours. The power of all civilizations is indicated on the
graph by lines in the civilization’s color. The higher a line climbs, the greater the power of the
civilization. Civilization’s that are destroyed have their lines fall to the bottom of the graph.
For this graph, power includes everything your civilization possesses, including cities,
population, improvements, Wonders, your treasury, and units.

Barbarians t 2 X XX3 Romans, Russians
HE N Americans, Chinese FHFFF ulus, Babylonians

Mongols, Indians Aztecs, Egyptians

[ -
Greeks, English et  Germans, French

Barbarian units and units from each pair of civilizations are distinguished in the black &
white version by the appearance of the noted graphics. Only one of each pair of civilizations
can be in the game at any time.
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Notes

Mouvement
Point Cost

Terrain

2

1

Defense
Bonus

0%
0%
50%
50%
100%
50%
200%
0%
0%
50%
0%

0%

Economic
Value

nothing
R

FRR
FF R?

FRR

FTT
FR

FFR?T

I

no effect
+1F
Plains

+1 F

+1 F
Grassland
no effect
no effect
+1F

+1F
Grassland

no effect

M

no etfect
+1 R

no effect
Forest
+1R
Forest
+1R

no effect
Forest
no effect
Forest

no effect

Road

no effect
+1T

no effect
+1T

no effect
no effect
no effect
no effect
+1T

no effect
no effect

no effect

1. I=irrigation or agriculture improvement; M = mining or industrialimprovement; F = food;

R =resources; T

= trade; R? = 50% chance of resource being present.

2. Government effects: Economic value of any commodity that equals three units or higher is

ol

-1 unit under Despo

under Republic/Democracy

Movement along Roads costs 1/3 movement points per square.

stism/Anarchy. Trade is +1 for any square already generating trade

Railroads increase all commodities by 50%, rounded down. Movement along Railroads

costs 0 movement points.



Special Resources

Terrain  Movement

Point Cost
. Coal 2
. Fish 1
. Game (For.) 2
. Game (Tun.) 1
. Gems 2
2 Gold J
. Horses 1
. Oasis 1
. Oil 2

. Seals 2mp

Defense
Bonus

100%
0%
50%
0%
50%
200%
0%
0%
50%

0%

Economic

Value

FRR
FFF TT
FFF RR
FFF

FTTIT

RTTTTIT

F RRR
FFF R

F RRRR

|

+1F
no effect
Horses

no effect

Grassland

no ettect

+1F

+1F

Grassland

no effect

M

+3 R

no effect
no effect
no effect
Game
+1R
Game
+1 R
Game

no effect

Road

no effect
no effect
no effect
no effect
no effect
no etfect
+17

+1T

no effect

no effect
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can earn you a free backup disk!
I Details on Backup Order Form.
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ONLINE SUPPORT SERVICES

MicroProse provides Upcoming News, Latest Versions,

Updates, Product Demos, Reviews, Technical Support and more on the
following Online Services for Modem Users. All are staffed by our Online
Service Representative, Quentin Chaney.

MicroProse Bulletin Board Service (MPS*BBS)

(410) 785-1841, with settings of 8,N,1, and supports up to 9600 baud, 8 Lines, 24 a day
7 days a week.

America Online: Industry Connection,

Keyword: "Microl’rose”, Address: Microl’rose

CompuServe: Game Publishers Forum,

Keyword: "Go GAMPUB", Address: 76004,2223

Delphi: GameSig, Address: MicroProse

Fidonet: MicroProse Conference, Node 1: 261/1153

GEnie: Scorpia RT, Keyword; "Scorpia”, Address: Microl’rose
Internet: Address: 76004,2223@CompuServe.Com

MCI Mail: Address: MicroProse

Prodigy: Game Club, Keyword: "MicroProse”, Address: XHFK15D




